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Welcome to the TestDirector Tutorial 

Welcome to the TestDirector Tutorial, a self-paced guide which teaches you 
how to use TestDirector, Mercury Interactive’s Web-based global test 
management tool. 

This tutorial instructs you on how to use TestDirector to manage the 
application testing process. It familiarizes you with specifying testing 
requirements, planning tests, executing tests, and tracking defects. It also 
shows you how to monitor the testing process by creating reports and 
graphs. 

TestDirector integrates with Mercury Interactive testing tools (WinRunner, 
LoadRunner, QuickTest Professional, Astra QuickTest, QuickTest Professional 
for MySAP.com Windows Client, Astra LoadTest, XRunner, Visual API, and 
Visual API-XP), as well as with third-party and custom testing tools. 

Before You Begin 

In order to do this tutorial, you must have access to the following 
components from your machine: 

✓	 TestDirector 7.6—Mercury Interactive’s Web-based test management tool. 
You must have access to the following modules: Requirements, Test Plan, 
Test Lab, and Defects. 

✓	 TestDirector_Demo—a demonstration project that helps introduce you to 
TestDirector and includes sample requirements, tests, test sets, test runs, and 
defects. 
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✓ Mercury Tours—a sample application which simulates a Web-based site for 
reserving flights, hotel rooms, car rentals, cruises, and vacation deals. 

Note: To access the TestDirector_Demo and Mercury Tours, you must install 
these components while installing TestDirector. For more information, see 
the TestDirector Installation Guide. 

To run the automated tests used in this tutorial, you also need one of the 
following testing tools: 

✓	 WinRunner 7.01 or higher—Mercury Interactive’s enterprise functional 
testing tool for Microsoft Windows applications; or 

✓	 QuickTest Professional 5.6 or higher—Mercury Interactive’s functional 
enterprise testing tool; or 

✓	 Astra QuickTest 5.6 or higher—Mercury Interactive’s functional enterprise 
testing tool for the Web. 

Note: To launch QuickTest Professional or Astra QuickTest from 
TestDirector, you must also install the QuickTest Professional/Astra 
QuickTest add-in from the TestDirector Add-ins page. Note that in certain 
cases, you must also install the TestDirector Connectivity add-in. For more 
information on installing the add-ins, see the TestDirector Installation Guide. 
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Using This Tutorial 

This tutorial contains the following lessons: 

Lesson 1 Introducing TestDirector 

Introduces you to the TestDirector testing process, and familiarizes you with 
the TestDirector user interface and the sample Mercury Tours Web site. 

Lesson 2 Specifying Testing Requirements 

Shows you how to define requirements, view and modify the requirements 
tree, and convert requirements. 

Lesson 3 Planning Tests 

Shows you how to create a test plan tree, design test steps, copy test steps, 
call a test with parameters, link tests to requirements, and automate your 
manual tests. 

Lesson 4 Running Tests 

Shows you how to define test sets, schedule test runs, and run manual and 
automated tests. 

Lesson 5 Adding and Tracking Defects 

Shows you how to add new defects, search for similar defects, update 
defects, e-mail defects, associate defects with tests, and create favorite views. 

Lesson 6 Analyzing the Testing Process 

Shows you how to monitor the testing process by creating reports and 
graphs. 

Lesson 7 Where Do You Go from Here? 

Shows you how to get started testing your own application and where to 
find more information about TestDirector. 
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Typographical Conventions 

This book uses the following typographical conventions: 

1, 2, 3 

➤ 

> 

Stone Sans 

Bold 

Italics 

Helvetica 

<> 

... 

Bold numbers indicate steps in a procedure. 

Bullets indicate options and features. 

The greater than sign separates menu levels (for 
example, File > Open). 

The Stone Sans font indicates names of interface 
elements in a procedure that you perform actions 
upon (for example, “Click the Run button.”). 

Bold text indicates function names. 

Italic text indicates variable names, or introduces a 
new term. 

The Helvetica font is used for examples and statements 
that are to be typed in literally. 

Angle brackets enclose a part of a URL address that 
needs to be typed in. 

In a line of syntax, an ellipsis indicates that more items 
of the same format may be included. 
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Introducing TestDirector 

Application testing is a complex process. TestDirector helps you organize 
and manage all phases of the application testing process, including 
specifying testing requirements, planning tests, executing tests, and tracking 
defects. 

In this lesson, you will learn about: 

➤ The TestDirector Testing Process 

➤ Starting TestDirector 

➤ The TestDirector Window 

➤ The Mercury Tours Sample Web Site 

The TestDirector Testing Process 

TestDirector offers an organized framework for testing applications before 
they are deployed. Since test plans evolve with new or modified application 
requirements, you need a central data repository for organizing and 
managing the testing process. TestDirector guides you through the 
requirements specification, test planning, test execution, and defect 
tracking phases of the testing process. 

The TestDirector testing process includes four phases: 

Specifying 
Requirements 

Planning 
Tests 

Running 
Tests 

Tracking 
Defects 
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Specifying Requirements 

You begin the application testing process by specifying testing requirements. 
In this phase you perform the following tasks: 

Task Description 

Define Testing Scope Examine application documentation in order to 
determine your testing scope—test goals, objectives, 
and strategies. 

Create Requirements Build a requirements tree to define your overall testing 
requirements. 

Detail Requirements For each requirement topic in the requirements tree, 
create a list of detailed testing requirements. Describe 
each requirement, assign it a priority level, and add 
attachments if necessary. 

Analyze Requirements 
Specification 

Generate reports and graphs to assist in analyzing your 
testing requirements. Review your requirements to 
ensure they meet your testing scope. 

Planning Tests 

You create a test plan based on your testing requirements. In this phase you 
perform the following tasks: 

Task Description 

Define Testing Strategy Examine your application, system environment, and 
testing resources in order to determine your testing 
goals. 

Define Test Subjects Divide your application into modules or functions to 
be tested. Build a test plan tree to hierarchically divide 
your application into testing units, or subjects. 

Define Tests Determine the types of tests you need for each 
module. Add a basic definition of each test to the test 
plan tree. 

Create Requirements 
Coverage 

Link each test with a testing requirement(s). 

2 



Lesson 1 • Introducing TestDirector 

Task Description 

Design Test Steps Develop manual tests by adding steps to the tests in 
your test plan tree. Test steps describe the test 
operations, the points to check, and the expected 
outcome of each test. Decide which tests to automate. 

Automate Tests For tests that you decide to automate, create test 
scripts with a Mercury Interactive testing tool, or a 
custom or third-party testing tool. 

Analyze Test Plan Generate reports and graphs to assist in analyzing test 
planning data. Review your tests to determine their 
suitability to your testing goals. 

Running Tests 

Once you build a test plan tree, you run your tests to locate defects and 
assess quality. In this phase you perform the following tasks: 

Task Description 

Create Test Sets Define groups of tests to meet the various testing goals 
in your project. These might include, for example, 
testing a new version or a specific function in an 
application. Determine which tests to include in each 
test set. 

Schedule Runs Schedule test execution and assign tasks to testers. 

Run Tests Execute the tests in your test set automatically or 
manually. 

Analyze Test Results View the results of your test runs in order to determine 
whether a defect has been detected in your 
application. Generate reports and graphs to help 
analyze these results. 
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Tracking Defects 

Locating and repairing application defects efficiently is essential to the 
testing process. Defects can be detected and added in all stages of the testing 
process. 

In this phase you perform the following tasks: 

Task Description 

Add Defects Report new defects detected in your application. 
Quality assurance testers, developers, project 
managers, and end users can add defects during any 
phase in the testing process. 

Review New Defects Review new defects and determine which ones should 
be fixed. 

Repair Open Defects Correct the defects that you decided to fix. 

Test New Build Test a new build of your application. Continue this 
process until defects are repaired. 

Analyze Defect Data Generate reports and graphs to assist in analyzing the 
progress of defect repairs, and to help determine when 
to release the application. 
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Starting TestDirector 

To get started, you need to launch TestDirector in your Web browser. 

To start TestDirector: 

1 Open the TestDirector Options window. 

In your Web browser type your TestDirector URL: 
http://[TestDirector server name]/[virtual directory name]/default.htm 

The TestDirector Options window opens. 

Note: If you cannot start TestDirector, contact your system administrator to 
ensure that TestDirector has been installed on your company Web server. 
For more information, refer to the TestDirector Installation Guide. 
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2 Open TestDirector. 

Click the TestDirector link. 

The first time you run TestDirector, the application is downloaded to your 
computer. Subsequently, TestDirector automatically carries out a version 
check. If it detects a newer version, it downloads it to your machine. 

The TestDirector Login window opens. 

3 Select a domain. 

In the Domain list, select the DEFAULT domain. 

4 Select a project. 

In the Project list, select the TestDirector_Demo. This is the demonstration 
project that you will use to do this tutorial. The project is based on the 
Mercury Tours sample application. It includes requirements, tests, test sets, 
test runs, and defects. 
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5 Log in to the project as a QA tester. 

In the User ID box, type one of the following user names: alice_td, cecil_td, 
or michael_td. 

Skip the Password box. A password was not assigned to any of the above 
user names. 

Click the Login button. 

TestDirector opens and displays the module in which you were last working. 
In the title bar, TestDirector displays the project name and your user name. 

Modules 

Project name 

User name 

The TestDirector Window 

In the following exercise, you will explore the TestDirector modules and 
their common elements. 

To explore the TestDirector window: 

1 Explore the TestDirector modules. 

➤	 Click the Requirements tab. The Requirements module enables you to 
specify your testing requirements. This includes defining what you are 
testing, defining requirement topics and items, and analyzing the 
requirements. 

➤	 Click the Test Plan tab. The Test Plan module enables you to develop a 
test plan. This includes defining goals and strategy, dividing your plan 
into categories, developing tests, automating tests where beneficial, and 
analyzing the plan. 

➤	 Click the Test Lab tab. The Test Lab module enables you to run tests on 
your application and analyze the results. 

➤	 Click the Defects tab. The Defects module enables you to add defects, 
determine repair priorities, repair open defects, and analyze the data. 
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2 Explore the common TestDirector elements. 

All the TestDirector modules have common elements. For example, click the 
Requirements tab. 

TestDirector 
toolbar 

Menu bar 

Module toolbar 

Tools button 

Help button 

Logout button 

➤	 The TestDirector toolbar, located directly above the TestDirector project 
name. If the toolbar is not visible, click the Show Toolbar button. The 
toolbar contains the following buttons: 

Button Description 

Navigates back to your previous location in 
TestDirector. 

If you navigated back, enables you to navigate 
forward. 

Logs out and takes you to the TestDirector Login 
window. 

Checks the spelling for the selected word or text box. 
If there are no errors, a confirmation message opens. 
If errors are found, the Spelling dialog box opens and 
displays the word together with replacement 
suggestions. 

Opens the Spelling Options dialog box, enabling you 
to configure the way TestDirector checks spelling. 
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Button Description 

Opens the Thesaurus dialog box and displays a 
synonym, antonym, or related word for the selected 
word. You can replace the selected word or look up 
new words. 

Opens the Add Defect dialog box, enabling you to add 
a new defect. 

Opens the Online Help and displays the help topic for 
the current context. 

➤	 The menu bar, located directly below the TestDirector project name, 
displays the names of menus from which you select commands. 

➤	 The module toolbar, located below the menu bar, contains buttons for 
frequently-used commands in the current TestDirector module. 

➤	 The Tools button, located on the upper-right side of the window, enables 
you to change your user password and other user properties, clear the 
history data, set reading order, view version information for each 
TestDirector client component, and open the Document Generator. 

➤	 The Help button, located on the upper-right side of the window, enables 
you to access TestDirector online resources. 

➤	 The Logout button, located on the upper-right side of the window, 
enables you to exit and return to the TestDirector Login window. 
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The Mercury Tours Sample Web Site 

Mercury Tours is the sample Web application used in lessons of this tutorial. 
It simulates a Web-based application for reserving flights, hotel rooms, car 
rentals, cruises, and vacation deals. You should now familiarize yourself 
with this application. 

To explore Mercury Tours: 

1 Open the Mercury Tours application. 

Open a separate instance of your Web browser, and type the following URL: 
http://[TestDirector server name]/mtours/index.html 

Make sure to replace [TestDirector server name] with your actual TestDirector 
server name. The Mercury Tours home page opens. 
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2	 Subscribe to Mercury Tours. 

Click Register. The Register page opens. 

Under Contact Information, type your name, phone number, and e-mail 
address. 

Under Mailing Information, type your mailing address. 

Under User Information, in the User Name box, type mercury. In the 
Password box, type mercury. In the Confirm Password box, type mercury. 

Click Submit. A confirmation of your registration is displayed in the Register 
page. 

11 
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3	 Log in to Mercury Tours. 

Click the sign-in link. The Sign-on page opens. 

In the User Name box, type mercury. In the Password box, type mercury. 
Click Submit. 
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The Flight Finder page opens. 

4 Reserve a flight. 

Follow the on-screen instructions to reserve a flight. 

5 Explore other options. 

Explore the following options: Hotels, Car Rentals, Cruises, Destinations, 
and Vacations. 

6 End your Mercury Tours session. 

Click SIGN-OFF to log out. 

Now that you are familiar with the TestDirector testing process, the 
TestDirector modules, and the Mercury Tours sample Web site, you can 
proceed to Lesson 2, “Specifying Testing Requirements.” 
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Specifying Testing Requirements 

You begin the testing process by specifying testing requirements in 
TestDirector’s Requirements module. Requirements describe in detail what 
needs to be tested in your application and provide the test team with a 
foundation on which the entire testing process is based. 

You define the requirements in TestDirector by creating a requirements tree. 
This is a graphical representation of your requirements specification, 
displaying your requirements hierarchically. You can group and sort 
requirements in the tree, monitor task allocation and progress of 
requirements, and generate detailed reports and graphs. 

Once you have created tests in the Test Plan module, you can link 
requirements to tests (you will do so, in “Planning Tests” on page 27), and 
associate them with defects (you will do so, in “Adding and Tracking 
Defects” on page 75). In this way, you can keep track of your testing needs at 
all stages of the testing process. If a testing requirement changes, you can 
immediately identify which tests and defects are affected, and who is 
responsible. 

In this lesson, you will learn about: 

➤ Defining Requirements 

➤ Viewing Requirements 

➤ Modifying Requirements 

➤ Converting Requirements 
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Defining Requirements 

In the following exercise, you will define requirements for testing the 
functionality of reserving cruises in Mercury Tours. 

To define a requirement: 

1 Open the TestDirector_Demo project. 

If the TestDirector_Demo project is not already open, log in to the project. 
For more information, see “Starting TestDirector,” on page 5. 

2 Display the Requirements module. 

Click the Requirements tab. The Requirements module displays the 
requirements tree. 

3 Display the requirement tree in Document View. 

Select the Document View of the requirement tree. 

4 Create a new requirement. 

Click the New Requirement button on the Requirements module toolbar. 
Alternatively, choose Requirements > New Requirement. The New 
Requirement dialog box opens. 

In the Name box, type Cruise Reservation. 
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In the Product box, select Mercury Tours (HTML Edition). 

In the Priority box, select 4-Very High. 

In the Type box, select Functional. 

Click OK. TestDirector adds the Cruise Reservation requirement to the 
requirements tree. 

5 Add a sub-requirement. 

Click the New Child Requirement button to add the next requirement 
underneath the Cruise Reservation, at a lower hierarchical level. The New 
Requirement dialog box opens. 

In the Name box, type Cruise Search. 

In the Product box, select Mercury Tours (HTML Edition). 

In the Priority box, select 4-Very High. 

In the Type box, select Functional. 

Click OK. TestDirector adds the Cruise Search requirement, under the Cruise 
Reservation requirement. 

6 Add an additional sub-requirement. 

In the requirements tree, select the Cruise Reservation requirement. 

Repeat step 5. This time in the Name box, type Cruise Booking. 

TestDirector adds the Cruise Booking requirement, under the Cruise 
Reservation requirement. 
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Viewing Requirements 

You can change the way TestDirector displays requirements in the 
requirements tree. In the following exercise, you will learn how to zoom in 
and out of the tree, display numeration, refresh the tree, and expand and 
collapse the branches of the tree. 

To view requirements: 

1 Display the Requirements module. 

Click the Requirements tab. The Requirements module displays the 
requirements tree. 

Make sure the requirements tree is displayed in Document view. 

2 Zoom in and out of the requirement. 

To zoom in, select Cruise Reservation in the requirements tree. 

Click the Zoom In button on the toolbar. Alternatively, right-click the 
requirement and choose Zoom In. The requirements tree only displays the 
Cruise Reservation requirement, including its two sub-requirements. 

To reverse a zoom in action, click the Zoom In arrow, and choose Zoom Out 
To Root. The entire requirements tree is displayed. 

18 



Lesson 2 • Specifying Testing Requirements 

3 Display numeration in the requirements tree. 

To assign hierarchical numbers to each requirement in the tree, choose 
View > Numeration. As you make changes to the tree, TestDirector 
automatically renumbers the requirements. Note that the numbers are not 
related to the unique Req ID assigned to each requirement. 

4 Refresh the data in the Requirements module. 

To refresh a requirement, select the requirement and click the Refresh 
Selected button. All children of the requirement are also refreshed. 

To refresh all requirements, click the Refresh Selected arrow and choose 
Refresh All. 

5 Expand and collapse the requirements. 

To expand all the levels in a requirement, right-click a requirement and 
choose Expand. 

To collapse all the levels in a requirement, right-click a requirement and 
choose Collapse. 
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Modifying Requirements 

You can modify the requirements in the requirements tree. In the following 
exercise, you will learn how to copy, rename, move, or delete requirements. 

To modify requirements: 

1 Display the Requirements module. 

Click the Requirements tab. The Requirements module displays the 
requirements tree. 

2 Copy a requirement. 

In the requirements tree, select the Cruise Reservation requirement and click 
the Copy button. 

Click the Paste arrow and choose Paste. 

A message box opens. Click OK. The requirement is pasted underneath the 
selected requirement, at the same hierarchical level. _Copy_ is added to the 
end of the requirement’s name. 

3 Rename the Cruise Reservation_Copy_ requirement. 

Right-click the Cruise Reservation_Copy_ requirement and choose Rename. 

Edit the requirement name to Hotel Reservation. 

Press Enter. 

4	 Move the Hotel Reservation requirement to a different location in the 
requirements tree. 

Select the Hotel Reservation requirement. 

Click the Cut button. 

Select the Reservations Management requirement. 

To paste the Hotel Reservation requirement underneath the selected 
requirement, click the Paste arrow and choose Paste as Child. 
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Click Yes to confirm. 

Tip: You can also drag requirements to a new location in the requirements 
tree. 

5 Delete the Hotel Reservation requirement. 

Select the Hotel Reservation requirement. 

Click the Delete button, or choose Requirements > Delete. 

Click Yes to confirm. 

Converting Requirements 

Once you have created the requirements tree, you use the requirements as a 
basis for defining your test plan tree in the Test Plan module. You can use 
the Convert to Tests wizard to assist you when designing your test plan tree. 
The wizard enables you to convert selected requirements or all requirements 
in the requirements tree to tests or subjects in the test plan tree. 

In the following exercise you will convert the Cruise Reservation 
requirement to a subject in the test plan tree. Its sub-requirements will be 
converted to tests. 

21 



TestDirector Tutorial 

To convert a requirement: 

1 Display the Requirements module. 

Click the Requirements tab. The Requirements module displays the 
requirements tree. 

2 Select a requirement. 

In the requirements tree, select the Cruise Reservation requirement. 

3 Open the Convert to Tests wizard. 

Choose Tools > Convert to Test > Convert Selected. The Step 1 dialog box 
opens. 

4 Choose an automatic conversion method. 

Select Convert all requirements to subjects to convert all selected 
requirements to subjects. 
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5 Start the conversion process. 

Click Next to begin converting the requirements. When the conversion 
process is complete, the results are displayed in the Step 2 dialog box. 

6	 Convert sub-requirements to tests. 

Select Cruise Search, and click the Test button. 

Select Cruise Booking, and click the Test button. 
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Click Next. The Step 3 dialog box opens. 

7 Choose the destination subject path. 

In the Destination Subject Path, click the browse button. The Select 
Destination Subject dialog box opens. 
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Select Cruises from your test plan tree. 

Click OK to close the Select Destination Subject dialog box. The Destination 
Subject Path box now indicates the following path: 

8 Finalize the conversion process. 

Click Finish. 

Click OK in the Information dialog box to close the Convert to Tests wizard. 

9 View the converted requirements in the test plan tree. 

Click the Test Plan tab to display the Test Plan module. 

In the test plan tree, select Cruises and click the Refresh Selected button. 
The test plan tree displays Cruise Reservation under Cruises. 
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Expand Cruise Reservation. The test plan tree displays Cruise Booking and 
Cruise Search as manual tests. 

Now that you are familiar with defining requirements, viewing and 
modifying the requirements tree, and converting requirements, you can 
proceed to Lesson 3, “Planning Tests”. In Lesson 3, you will learn how to 
define your test plan tree. 
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Planning Tests 

After you define your requirements, you need to determine your testing 
goals. Examine your application, system environment, and testing process 
to outline the testing strategy for achieving your goals. 

After you determine your testing goals, you build a test plan tree to 
hierarchically divide your application into testing units, or subjects. For each 
subject in the test plan tree, you define and design tests. 

When you define steps for a test, you provide the actions to be performed 
on your application, the input to be entered, and the expected output. To 
increase the flexibility of a test, you can add parameters. 

To keep track of the relationship between your tests and requirements, you 
can add links between them. By creating these links, you can ensure 
compliance with your requirements throughout the testing process. 

Once you design your tests, you can decide which tests to automate. If you 
choose to automate a test, you can generate a test template and then 
complete it using other Mercury Interactive testing tools (for example, 
WinRunner, QuickTest Professional, or Astra QuickTest). 

In this lesson, you will learn about: 

➤ Developing a Test Plan Tree 

➤ Designing Test Steps 

➤ Copying Test Steps 

➤ Calling Tests with Parameters 

➤ Creating Requirements Coverage 

➤ Generating Automated Test Templates 
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Developing a Test Plan Tree 

The typical application is too large to test as a whole. The Test Plan module 
enables you to divide your application according to functionality. You 
divide your application into units, or subjects, by creating a test plan tree. 
This is a graphical representation of your test plan, displaying your tests 
according to the hierarchical relationship of their functions. After you 
define subjects in the tree, decide which tests to create for each subject and 
add them to the tree. 

In the Requirements module, you converted the Cruise Reservation 
requirement, and its sub-requirements to subjects and tests in the test plan 
tree ( see “Converting Requirements,” on page 21). In the following exercise, 
you will add a subject and a test to the test plan tree from the Test Plan 
module. 

To develop a test plan tree: 

1 Open the TestDirector_Demo project. 

If the TestDirector_Demo project is not already open, log in to the project. 
For more information, see “Starting TestDirector,” on page 5. 

2 Display the Test Plan module. 

Click the Test Plan tab. 

3 Add a subject folder to the test plan tree. 

Select the Cruises subject folder, and click the New Folder button. The New 
Folder dialog box opens. 

In the Folder Name box, type Cruise Cancellation. Click OK. The new subject 
folder appears under the Cruises subject folder in the test plan tree. 
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In the Description tab, type a description of the subject. For example, 
type: This folder contains tests that verify the Cancel Reservation functionality. 

Click the Attachments tab. In this tab, you can add an attachment to the 
new folder if necessary. For the purpose of this exercise, ignore this tab. 

4 Add a test to the test plan tree. 

Select the Cruise Cancellation subject folder, and click the New Test button. 

The Create New Test dialog box opens.


In Test Type box, select WR-AUTOMATED to create a WinRunner test, or

select QUICKTEST-TEST to create a QuickTest Professional/Astra QuickTest 

test.


In the Test Name box, type a name for the test. For example, type: Cancel All

Reservations. 


Click OK. The Required Fields dialog box opens.


In the Level box, select Basic. 


In the Reviewed box, select Not Reviewed.


In the Priority box, select 4-Very High.


Click OK. 
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The new test is added to the test plan tree under the Cruise Cancellation 
subject folder. 

5 Add a test description. 

Make sure to display the Details tab. By default, the Details tab shows the 
test name, test creator, creation date, and test status. 

In the Description box, type a description for the test. For example, type: 
The test verifies cancellation of cruise reservations in the Itinerary page. 

6 Display the Design Steps tab. 

Click the Design Steps tab. In the Design Steps tab you define your test 
steps. For the purpose of this exercise, ignore this tab. You will define test 
steps in the “Designing Test Steps” exercise on page 31. 

7 Display the Test Script tab. 

Click the Test Script tab. In the Test Script tab, you can view the test script of 
a test. For the purpose of this exercise, ignore this tab. You will create an 
automated test template in the “Generating Automated Test Templates” 
exercise on page 44. 

8 Display the Attachments tab. 

Click the Attachments tab. In the Attachments tab, you can view the list of 
attachments that provide additional information on the test. An attachment 
can be a file, URL, snapshot of your application, an image from the 
Clipboard, or system information. For the purpose of this exercise, ignore 
this tab. 
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9 Display the Reqs Coverage tab. 

Click the Reqs Coverage tab. In the Reqs Coverage tab you can view a list of 
the requirements that are covered by the selected test. For the purpose of 
this exercise, ignore this tab. You will link requirements to a test in the 
“Creating Requirements Coverage” exercise on page 44. 

Designing Test Steps 

After you add a test to the test plan tree and define basic test information, 
you define test steps—detailed, step-by-step instructions on how to execute 
a test. A step includes the actions to be performed on your application, the 
input to be entered, and the expected output. A step can also include 
parameters. 

You can create test steps for both manual and automated tests. For a manual 
test, you complete test planning and design once you finish creating the 
steps. Using your plan, you can begin execution immediately. Automated 
tests require that you create an automated test script using a Mercury 
Interactive testing tool, or a custom or third-party testing tool. 

In the following exercise, you will create the Cruise Booking test. This test 
verifies the process of booking a cruise through the Mercury Tours site. 

To design a test step: 

1 Display the Test Plan module. 

Click the Test Plan tab. 

2 Display the Cruise Booking test. 

Under the Cruise Reservation folder, select the Cruise Booking test. 
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3	 Open the Design Step Editor. 

Click the Design Steps tab. 

Click the New Step button. The Design Step Editor opens. 

The Test Plan module displays a step name in the Step Name box. The 
default name is the sequential number of the test step (Step 1 if you are 
adding steps to a test for the first time). 

4 Define a step for displaying the Cruise Special page. 

In the Step Name box, type a descriptive name for the step. For example, 
type: Display the Cruise Special page. 

In the Description box, type the procedure for the step. For example, type: 
Click the Cruises button. 
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In the Expected Result box, type the expected output. For example, type: 
The Cruise Special page opens. 

5 Define a step for reserving the cruise. 

Click the Add Step button. 

In the Step Name box, type: Display the Cruise Reservation page. 

In the Description box, type: Click the Now Accepting Reservations button. 

In the Expected Result box, type: The Cruise Reservation page opens. 

6 Define a step for booking the cruise. 

Click the Add Step button. 

In the Step Name box, type: Book the cruise. 

In the Description box, type: Enter passenger name, credit card information, 
and address. Click OK. 

In the Expected Result box, type: The Cruise Confirmation page opens. 
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7 Define a step for printing the cruise confirmation information. 

Click the Add Step button. 

In the Step Name box, type: Print cruise confirmation. 

In the Description box, type: Click the Print button. 

In the Expected Result box, type: A confirmation page is printed. 

8 Define a step for logging off the Mercury Tours site. 

Click the Add Step button. 

In the Step Name box, type Log off. 

In the Description box, type: Click the Sign-Off button. 

In the Expected Result box, type: Returns to the Sign-On page. 

9 Close the Design Step Editor. 

Click Close. The designed steps are displayed in the Design Steps tab. 
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Copying Test Steps 

You can copy steps from another test in the same project or a different 
project. In the following exercise, you will copy the test steps from the 
Cruise Booking test and paste them into the Cruise Search test. In 
“Generating Automated Test Templates” on page 44, you will automate the 
Cruise Search test. 

To copy a test step: 

1 Display the Design Steps tab for the Cruise Booking test. 

In the test plan tree, under the Cruise Reservation folder, select the Cruise 
Booking test. 

Click the Design Steps tab. 

2 Select the steps that you want to copy. 

Press the Ctrl or Shift key and select the first column (shaded a gray or 
brown color) of all the steps. 

3	 Copy the selected steps. 

Click the Copy Steps button. 
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4 Paste the steps to the Cruise Search test. 

In the test plan tree, under the Cruise Reservation folder, select the Cruise 
Search test. 

In the Design Steps tab, click the Paste Steps button. The test steps appear 
in the Design Steps tab. 

Calling Tests with Parameters 

When you design test steps, you can include a call to a manual test. When 
you run the test, the test steps include the steps from the called test as part 
of the test. Generally, the test that you call is a template test. A reusable test 
that can be called by different tests. A template test generally includes 
parameters. A parameter is a variable that replaces a fixed value and can be 
assigned a value from outside the test in which it is defined. You can change 
the value of a parameter in a test according to the test that is calling it, or for 
different instances of a test. 

For example, suppose you have a template test which logs in a user with a 
specific password when you start your application. You need to call this test 
at the beginning of each test. In some cases, you will want to log in as a 
regular user while in others, you will need to log in as the administrator. You 
can therefore create two parameters, <<user name>> and <<password>>, and 
change the value according to which type of test is calling your template 
test. 

In “Designing Test Steps” on page 31, you created a test for booking a cruise. 
In the following exercise, you will enhance your test by calling the Connect 
And Sign-On test. This is a template test which includes parameters for the 
Mercury Tours URL address, and the user name and password for logging in 
to the site. 
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To call a test with parameters: 

1 Display the Design Steps tab for the Cruise Booking test. 

In the test plan tree, under the Cruise Reservation folder, select the Cruise 
Booking test. 

Click the Design Steps tab. 

2	 Select the test with parameters that you want to call. 

Click the Call to Test button. The Select a Test dialog box opens. 

To locate the Connect And Sign-On test, in the Find box, type Connect, and 
click the Find button. TestDirector highlights the test. 
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Click OK. A dialog box opens, displaying the parameters contained in the 
called test. 

3 Assign values for the parameters. 

Click the Value box for the mercury tours url parameter, and type: 
http://[TestDirector server name]/mtours/index.html 

Make sure to replace [TestDirector server name] with your actual TestDirector 
server name. 

Click the Value box for the user name parameter, and type your user name 
(use the same name as the one used in “The Mercury Tours Sample Web 
Site” on page 10). 

Skip the value for the password parameter. You will assign a value to this 
parameter when you run your test ( “Running Tests Manually” on page 61). 
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Note: You can also assign values to parameters when you create a test to call 
your test, when you add your test to a test set, or when you run your test. 

Click OK. The Call Connect And Sign-On step is added to your designed 
steps. 

4 Reorder the steps. 

In the Design Steps tab, select the first column (shaded a gray or brown 
color) of the Call Connect And Sign-On step. The mouse pointer changes to 
a plus (+) sign. 

Click and drag the step to the top row. 
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Creating Requirements Coverage 

It is essential that the tests in your test plan comply with your testing 
requirements. To help ensure compliance throughout the testing process, 
you can add links between your tests and requirements from the Test Plan 
module and from the Requirements module. 

In the Test Plan module, you create requirements coverage by selecting 
requirements to link to a test. Alternatively, in the Requirements module, 
you create tests coverage by selecting tests to link to a requirement. A test can 
cover more than one requirement, and a requirement can be covered by 
more than one test. 

To further ensure compliance with your testing requirements, you can link 
your tests to defects (you will do so, in “Associating Defects with Tests” on 
page 86). This helps you ensure that if a testing requirement changes, you 
can immediately identify which tests and defects are affected, and who is 
responsible. 

In the following exercises, you will create requirements coverage and tests 
coverage. 

Linking Requirements to a Test 

In the following exercise you will create requirements coverage by linking 
the Cruise Booking requirement to the Cruise Booking test. 

To link a requirement to a test: 

1 Display the Test Plan module. 

Click the Test Plan tab. 

2 Display the Cruise Booking test. 

Under the Cruise Reservation folder, select the Cruise Booking test. 

3 Display the Reqs Coverage tab. 

Click the Reqs Coverage tab. 
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4	 Display the requirements tree. 

Click the Select Req button to show the requirements tree on the right. 

Coverage 
grid 

tree 
Requirements 

5 Search for the Cruise Booking requirement in the requirements tree. 

In the Find box, type Cruise Booking, and click the Find button. TestDirector 
highlights the requirement in the tree. 

6 Add the requirement to the coverage grid. 

Click the Add to Coverage button. The Cruise Booking requirement is 
added to the coverage grid. 

Tip: You can also drag a requirement or requirement topic in the 
requirements tree to the coverage grid. 

7	 Hide the requirements tree. 

Click the Close button. 
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Linking Tests to a Requirement 

In the following exercise, you will create tests coverage by linking the Cruise 
Search test to the Cruise Booking requirement. 

To link a test to a requirement: 

1 Display the Requirements module. 

Click the Requirements tab. 

2 Display the requirement tree in Coverage View. 

Select the Coverage View of the requirement tree. 

The Test Coverage tab is displayed. 

3 Display the Cruise Booking requirement. 

In the requirement tree, select the Cruise Booking requirement. 

4 Display the test plan tree. 

In the Test Coverage tab, click the Select Tests button to show the test plan 
tree on the right. 

5 Select the Cruise Booking test in the test plan tree. 

Expand the Cruise Reservation sub-folder located in the Cruises folder. 

Select the Cruise Search test. 
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6 Add the test to the coverage grid. 

Click the Add to Coverage button. The Cruise Search test is added to the 
coverage grid. The coverage grid lists the tests that cover the selected 
requirement. 

In the above example, the coverage grid indicates that the Cruise Booking 
and the Cruise Search tests provide coverage for the Cruise Booking 
requirement. 

Tip: You can also drag a test or a subject folder in the test plan tree to the 
coverage grid. 

7	 Hide the test plan tree. 

Click the Close button. 
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Generating Automated Test Templates 

Test planning involves deciding which tests to automate. If you choose to 
perform tests manually, the tests are ready for execution as soon as you 
define the test steps. If you choose to automate tests, you can generate test 
templates and complete them using other Mercury Interactive testing tools 
(for example, WinRunner, QuickTest Professional, or Astra QuickTest). 

Consider the following issues when deciding whether to automate a test. 

Do automate: • Tests that will run with each new version of your 
application to check the stability of basic 
functionality across the entire application 
(regression test). 

• Tests that use multiple data values for the same 
operation (data-driven tests). 

• Tests that are run many times (stress tests) and tests 
that check a multi-user client/server system (load 
tests). 

Do not automate: • Tests that will be executed only once. 

• Tests that require immediate execution. 

• Tests that check how easy the application is to use 
(usability tests). 

• Tests that do not have predictable results. 

In the following exercise, you will generate an automated test template for 
the Cruise Search test. 
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To generate an automated test template: 

1 Display the Test Plan module. 

Click the Test Plan tab. 

2 Locate the manual test that you want to automate. 

To find the test in the test plan tree, select the Subject folder and click the 
Find Folder/Test button. The Find Folder/Test dialog box opens. 

In the Value to Find box, type Cruise. 

Check Include Tests to instruct TestDirector to search for folders and tests. 

Click Find. The Search Results dialog box opens and displays a list of 
possible matches. 

Select Cruises\Cruise Reservation\Cruise Search, and click the Go To button 
to highlight the test in the test plan tree. 

Click Close to the close the Search Results dialog box. 

3 Display the Design Steps tab. 

Click the Design Steps tab. 

4 Generate a test template. 

Click the Generate Script button. 

Choose WR-AUTOMATED to generate a WinRunner test type, or choose 
QUICKTEST-TEST to generate QuickTest Professional or Astra QuickTest test. 

45 



TestDirector Tutorial 

Note: The QUICKTEST-TEST test type is only available if you have installed 
the QuickTest Professional/Astra QuickTest add-in from the TestDirector 
Add-ins page. For more information on installing the add-in, see the 
TestDirector Installation Guide. 

The Test Plan module uses the steps of the Cruise Search test to create an 
automated test template. In the test plan tree, note that the manual test 
icon  next to the test is now replaced with the automated test icon. 

5 View the test template. 

Click the Test Script tab. 

To display your test template in the testing tool in which it was created, 
click the Launch button. You can now modify your test. 

Now that you are familiar with creating a test plan tree, designing test steps, 
copying test steps, calling a test with parameters, linking tests to 
requirements, and automating your manual tests, you can proceed to 
Lesson 4, “Running Tests”. In Lesson 4, you will learn how to run your 
manual and automated tests. 
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Running Tests 

Running tests is the core of the testing process. As your application changes, 
you run the manual and automated tests in your project in order to locate 
defects and assess quality. 

You start by creating test sets and choosing which tests to include in each set. 
A test set is a group of tests in a TestDirector project database designed to 
achieve specific testing goals. TestDirector enables you to control the 
execution of tests in a test set. You can set conditions, and schedule the date 
and time for executing your tests. 

Once you have defined test sets, you can begin executing your tests. When 
you run a test manually, you execute the test steps you defined in test 
planning. You pass or fail each step, depending on whether the application’s 
actual results match the expected output. When you run a test 
automatically, TestDirector opens the selected testing tool, runs the test, and 
exports the test results to TestDirector. 

In this lesson, you will learn about: 

➤ Defining Test Sets 

➤ Adding Tests to a Test Set 

➤ Scheduling Test Runs 

➤ Running Tests Manually 

➤ Running Tests Automatically 
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Defining Test Sets 

You can organize test runs by building test sets. You build test sets by 
selecting automated and/or manual tests from the test plan tree. Note that 
you can include the same tests in different test sets. When you run the tests, 
results are stored separately for the different test instances. 

To decide which test sets to create, think about the testing goals you defined 
at the beginning of the testing process. Following are examples of general 
categories of test sets you could create: 

Test Set Description 

Sanity Tests the entire application at a basic level to check that it is 
functional and stable. 

Normal Tests the system in a more in-depth manner than the sanity test. 
A Normal test set can contain both positive and negative checks. 
Positive checks test that the application responds to input as 
expected. Negative tests attempt to crash an application in order 
to demonstrate that the application is not functioning properly. 

Advanced Checks the entire application, including its most advanced 
features. 

Regression Verifies that a change to one part of the application did not 
prevent the rest of the application from functioning. 

Function Tests a specific feature or a group of features in the application. 

In the following exercise, you will define the Mercury Tours Demo test set. 
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To define a test set: 

1 Open the TestDirector_Demo project. 

If the TestDirector_Demo project is not already open, log in to the project. 
For more information, see “Starting TestDirector,” on page 5. 

2 Display the Test Lab module. 

Click the Test Lab tab. 

3 Add a test set to the Test Sets list. 

Click the New Test Set button or choose Test Sets > New Test Set. The New 
Test Set dialog box opens. 

In the Test Set Name box, type a name for the test set. For example, type: 
Mercury Tours Demo. 

In the Description box, type a description of the test set. For example, type: 
This test set includes tests that verify the functionality of the Mercury Tours site. 

Click OK. The Mercury Tours Demo test set is added to the Test Sets list in 
the left window pane. 
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4	 Define the test set details. 

Click the Test Set Properties tab and select the Details link. 

By default, the Status indicates that the test set is Open. 

In the Open Date box, select a date from the calendar. By default, 
TestDirector displays the current date. 

In the Close Date box, select the planned closing date for the test set. 

For the purpose of this exercise, skip the following fields: Level, Version, and 
Project. 

5 Display the test set attachments. 

Click the Attachments link. You can add an attachment to the test set. An 
attachment can be a file, URL, snapshot of your application, an image from 
the Clipboard, or system information. For the purpose of this exercise, skip 
this option. 
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6	 Set rules for the automated tests in the test set in the event of a test 
failure. 

Click the On Failure link. 

Select the first check box to set the test set on failure rule. Make sure that the 
number of times an automated test should be rerun is set to 1. 

The second check box enables you to include a clean up test from the test 
plan tree. For the purpose of this exercise, skip this option. 

The Settings per test link enables you to change the above on failure rules 
for any test in the test set. For the purpose of this exercise, skip this option. 

In On final test failure, you can instruct TestDirector, after the final test 
failure, to do nothing, stop the test set, or run the test set again a specified 
number of times. Make sure that the Do nothing option is selected. 
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7	 Instruct TestDirector to send an e-mail to specified users if certain 
events occur. 

Click the Notifications link. 

Select the first check box to send a notification if any test in the test set fails. 

To specify who should receive the e-mail, type your actual e-mail address in 
the To box. 

In the Message box, type a message for the e-mail. For example, type: This 
test failed. Please review the test results and submit a defect. 
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Adding Tests to a Test Set 

Once you have defined a test set, you can add copies of tests from the 
project to your test set. In the following exercise, you will add tests to the 
Mercury Tours Demo test set. 

To add a test to a test set: 

1 Display the Test Lab module. 

Click the Test Lab tab. 

2 Display the Execution Grid tab. 

Select the Mercury Tours Demo test set from the Test Sets list. 

Click the Execution Grid tab. 

3 Display the test plan tree. 

Click the Select Tests button. The right window pane displays the test plan 
tree. 
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4 Add the Cruises folder to the test set. 

Select the Cruises folder, and click the Add Tests to Test Set button. 

The Parameter dialog box opens if a test that you are adding to a test set has 
an unassigned parameter value. You can assign a value now, or later when 
you run the test. For the purpose of this exercise, click OK to close this 
dialog box. You will assign this parameter value when you run the Cruise 
Booking test (see “Running Tests Manually” on page 61). 

TestDirector adds all the tests in the folder to the test set. 

5 Add the Airline Preference test to the test set. 

To search for the test, type Airline in the Find box, and click the Find button. 
TestDirector highlights the Airline Preference test in the test plan tree. 

Click the Add Tests to Test Set button. TestDirector adds the test to the test 
set. 

6 Add the Number of Passengers test to the test set. 

To search for the test, type Number of Passengers in the Find box, and click 
the Find button. TestDirector highlights the test in the test plan tree. 

Click the Add Tests to Test Set button. TestDirector adds the test to the test 
set. 

Tip: You can also add tests by dragging a folder or test in the test plan tree to 
the Execution Grid or Execution Flow. 

7	 Close the test plan tree window pane. 

Click the Close button. 
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Scheduling Test Runs 

You can specify a date and time, and set conditions for executing a test in 
the Execution Flow tab. A condition is based on the results of another 
specified test in the Execution Flow. By setting conditions, you can instruct 
TestDirector to postpone execution of the current test until the other 
specified test has either finished running or passed. You can also set the 
sequence in which to execute the tests. 

For example, suppose you schedule to run Test 2 only after Test 1 has 
finished, and run Test 3 only if Test 2 passed. You can also schedule Test 1 
and Test 2 to run a day before Test 3. Unlike the Execution Grid, which 
displays the tests with only test run information, the Execution Flow 
displays the tests with conditions in a diagram. 
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A dashed line arrow indicates a test with no conditions. A solid 
line  arrow indicates a condition and can be blue or green. If the 
solid line is blue, it indicates that the condition status is set to “Finished”. If 
the solid line is green, it indicates that the condition is set to “Passed”. 
When a test is time-dependent, a Time Dependency  icon is added to the 
diagram. 

In the following exercise, you will create a new test set, and add to it three 
tests that verify the login procedure on the Sign-On page of the Mercury 
Tours site. Then, you specify under what conditions you want to run each 
test and when. 

To schedule a test run: 

1 Create a test set for this exercise. 

In the Test Lab module, click the Execution Flow tab. 

Click the New Test Set button. The New Test Set dialog box opens. 

In the Test Set Name box, type: Test Run Schedule. 

In the Description box, type: This test set is used to explain how to schedule a 
test run. 

Click OK. The Test Run Schedule test set is added to the Test Sets list in the 
left window pane, and the right window pane displays the test plan tree. 

2	 Add tests from the Sign-On/Sign-Off folder to the Test Run Schedule test 
set. 

To search for the Sign-On/Sign-Off folder , type Sign in the Find box, and 
click the Find button. TestDirector highlights the Sign-On/Sign-Off folder in 
the test plan tree. 

Select the Sign-On Page test. Click the Add Tests to Test Set button. 
TestDirector adds the test to the test set. 

Drag the Sign-On User Name test to the Execution Flow area. 
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Drag the Sign-On Password test to the Execution Flow area. 

3 Add an execution condition to the Sign-On User Name test. 

Right-click the Sign-On User Name test and choose Test Run Schedule. The 
Run Schedule of Test dialog box opens and displays the Execution 
Conditions tab. 
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Click New. The New Execution Condition dialog box opens. 

In the Test box, select Sign-On Page. 

Select Passed to instruct that the Sign-On User Name be executed only if the 
Sign-On Page test has finished executing and passed. 

Click OK. The condition is added to the Run Schedule of Test dialog box. 
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4	 Add a time dependency condition to the Sign-On User Name test. 

Click the Time Dependency tab. 

Select Run At Specified Time, and select tomorrow’s date from the Date box. 

Click OK to close the Run Schedule of Test dialog box. Your conditions are 
displayed in the Execution flow diagram. 
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5 Add an execution condition to the Sign-On Password test. 

Add the same execution condition as described in Step 3 on page 57 for the 
Sign-On Password test. This time select Sign-On User Name from the Test 
box in the New Execution Condition dialog box. 

6 Add a time dependency condition to the Sign-On Password test. 

Add the same execution condition as described in Step 4 on page 59 for the 
Sign-On Password test. 

Click OK to close the Run Schedule of Test dialog box. Your conditions are 
displayed in the Execution flow diagram. 
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7 Rearrange the tests in a hierarchical layout. 

To clearly view dependencies between different tests, click the Arrange Tests 
Sequentially button. 

Running Tests Manually 

When you run a test manually, you follow the test steps and perform 
operations on your application. You compare the expected results with the 
actual outcome and record the results. You can execute a test as many times 
as you want. Test results are stored separately for each run. 

Note that you can run both manual and automated tests manually. You can 
choose to run a single test or run an entire test set. 

In the following exercise, you will run the Cruise Booking test. 
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To run a test manually: 

1 Display the Test Lab module. 

Click the Test Lab tab. 

2 Select the Mercury Tours Demo test set. 

In the Test Sets list, select the Mercury Tours Demo test set. 

3	 Select the Cruise Booking test from the Execution Grid. 

In the Execution Grid tab, select the Cruise Booking test. 

Click the Run button. The Manual Runner dialog box opens. 
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Under Run Details, you can view and modify test run details. In the Test 
Details box, you can view a description of the test that you are running. 

4 Start the test run. 

Click the Exec Steps button. 

Because the test that you are running has one unassigned parameter, the 
Parameters dialog box opens, enabling you to assign a value. 

5 Assign a value for the password parameter. 

Click the Value box for the password parameter, and type mercury (this is the 
the same password as the one used in “The Mercury Tours Sample Web Site” 
on page 10). 
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Click OK. The Manual Runner: Step Details dialog box opens. 
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6 Display the Manual Runner dialog box in a compact view. 

To conveniently read each test step and record the results using the compact 
view display of this dialog box, click the Compact View button. 

7 Perform the first step. 

Perform the procedure described in the Description box. 

If the actual result is the same as the expected result, in the Actual box, type: 
The Mercury Tours site opens. 

Click the Passed button. TestDirector adds a green check to the step and 
changes the step status to Passed. 

8 Perform the second step. 

Perform the procedure described in the Description box. 

If the actual result is the same as the expected result, in the Actual box, type: 
The Flight Finder page opens. 

Click the Passed button. TestDirector adds a green check to the step and 
changes the step status to Passed. 
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9 Perform the third step. 

Perform the procedure described in the Description box. 

If the actual result is the same as the expected result, in the Actual box, type: 
The Cruise Special page opens. 

Click the Passed button. TestDirector adds a green check to the step and 
changes the step status to Passed. 

10 Perform the fourth step. 

Perform the procedure described in the Description box. 

If the actual result is different than the expected result, in the Actual box, 
type: The Flight Finder page opens instead of the Cruise Reservation page. 

Click the Failed button. TestDirector adds a red X to the step and changes 
the step status to Failed. 

Note that when you detect an application flaw while running the test, you 
can click the Add Defect button to open the Add Defect dialog box and add 
a defect. For the purpose of this exercise, you will submit this defect in 
“Adding New Defects,” on page 77. 

11 Return to the default display of the Manual Runner. 

Click the Back to Steps Grid button. The default display of the Manual 
Runner: Step Details dialog box is displayed. 

12 End the test run. 

Click the End of Run button to end your test run. 
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13 View the test run results in the Execution Grid. 

Following the execution of your test, you can view the test run results of 
your last run in the Execution Grid. Note that the status for the test run is 
updated from “No Run” to “Failed”. 

14 View the results of each test step in the Last Run Results pane. 

If the Last Run Result pane is not displayed, click View > Last Run Result. 
The Last Run Result pane is displayed below the Execution Grid. 

Click each step in the Last Run Result pane to view the step’s description, as 
well as the expected and actual results. 

Note that you can view more detailed results in the Test Run Properties 
dialog box (see “Running Tests Automatically” on page 68). 
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Running Tests Automatically 

When you run an automated test, TestDirector opens the selected testing 
tool automatically, runs the test on your local machine or on remote hosts, 
and exports the results to TestDirector. 

Note that you can run all tests in a test set or run specific tests. You can run 
tests from the Execution Grid tab or the Execution Flow tab. 

In the following exercise, you will run an automated test from the Mercury 
Tours Demo test set. After the test run is complete, you will view the test 
results from the Test Run Properties dialog box. 

Note: To perform the following exercise, you must have one of the 
following tools installed on your computer: 

➤ WinRunner 7.01 or higher 

➤ QuickTest Professional 5.6 or higher 

➤ Astra QuickTest 5.6 or higher 

To launch QuickTest Professional or Astra QuickTest from TestDirector, you 
must also install the QuickTest Professional/Astra QuickTest add-in from the 
TestDirector Add-ins page. Note that in certain cases, you must also install 
the TestDirector Connectivity add-in. For more information on installing 
the add-ins, see the TestDirector Installation Guide. 

To run a test automatically: 

1	 Display the Mercury Tours Demo test set in the Execution Grid. 

Click the Test Lab tab. 

Click the Execution Grid tab. 

Select the Mercury Tours Demo test set from the Test Sets list. 
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2 Select a test. 

To run a WinRunner test, select the Airline Preference test. 

To run a QuickTest Professional or Astra QuickTest test, select the Number of 
Passengers test. 

Click the Run button, or choose Execution > Run. The Execution dialog box 
opens and displays the selected test. 

3 Set the test run settings. 

Select the Run All Tests Locally check box to run the test on your local 
computer. 

You can instruct TestDirector to create an execution log file during the test 
run. For the purpose of this exercise, ignore the Enable Log option. 
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4 Run the test. 

Click Run. 

TestDirector opens the selected testing tool automatically and runs the test. 
You view the test execution progress in the Status column. 

5	 Close the Execution dialog box. 

After the test run is complete, click Close. 
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6 View a summary of test results in the Execution Grid tab. 

The updated status for the test run appears in the Execution Grid tab. 
Results for each test step appear in the Last Run Results pane. 
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7 View detailed test results from the Test Run Properties dialog box. 

Make sure your test is selected in the Execution Grid. Click the Test Run 
Properties button. The Test Run Properties dialog box opens and displays 
the All Runs tab. 

8 View the results in the All Runs tab. 

TestDirector lets you compare the results of a test run with the results of 
previous runs. You can view run details and step results for all the runs of a 
selected test. 
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9 View the test results in your selected testing tool. 

➤	 To view the test results in WinRunner, click the View Report button in 
the All Runs tab. The WinRunner Test Results window opens. 

Choose File > Exit to close the WinRunner Test Results Window. 

➤	 To view the test results in QuickTest Professional or Astra QuickTest, click 
the Launch Report button in the All Runs tab. The Test Results window 
opens. 

Choose File > Exit to close the Test Results Window. 

10 View other test run information in the Test Run Properties dialog box. 

➤ To view run details of a test, click the Details tab. 

➤ To view any attachments to a test, click the Attachment tab. 

➤	 To view the test parameters, click the Run Configuration tab. This tab also 
enables you to set parameters for a manual test or a WinRunner test. 
Note that any changes that you make will be implemented in the next 
test run. 

➤	 To view the rules in the event that the test fails, click the Run Events tab. 
This tab also enables you to change your rules. Note that any changes 
that you make will be implemented in the next test run. 

➤ To view a list of changes made to the test run field, click the History tab. 

11 Close the Test Run Properties dialog box. 

Click Close. 

12 Close your selected testing tool. 

In WinRunner, choose File > Exit. 

In QuickTest Professional or Astra QuickTest, choose File > Exit. 

Now that you are familiar with how to define and build test tests, schedule 
test runs, and run tests manually or automatically, you can proceed to 
Lesson 5, “Adding and Tracking Defects”. In Lesson 5, you will learn how to 
add and track defects. 
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Adding and Tracking Defects 

Locating and repairing defects is an essential phase in application 
development. Defects can be detected and reported by developers, testers, 
and end users in all stages of the testing process. Using TestDirector, you can 
report defects detected in the application, and track them until they are 
repaired. 

In this lesson, you will learn about: 

➤ How to Track Defects 

➤ Adding New Defects 

➤ Matching Defects 

➤ Updating Defects 

➤ Mailing Defects 

➤ Associating Defects with Tests 

➤ Creating Favorite Views 
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How to Track Defects 

When you report a defect to a TestDirector project, it is tracked through the 
following stages: New, Open, Fixed, and Closed. A defect may also be Rejected, 
or Reopened after it is fixed. 

Rejected New 

Open 

Reopened 

Fixed 

Closed 

When you initially report the defect to the TestDirector project, by default it 
is assigned the status New. A quality assurance or project manager reviews 
the defect, and determines whether or not to consider the defect for repair. 
If the defect is refused, it is assigned the status Rejected. If the defect is 
accepted, the quality assurance or project manager determines a repair 
priority, changes its status to Open, and assigns it to a member of the 
development team. A developer repairs the defect and assigns it the status 
Fixed. You retest the application, making sure that the defect does not recur. 

If the defect recurs, the quality assurance or project manager assigns it the 
status Reopened. If the defect is actually repaired, it is assigned the status 
Closed. 
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Adding New Defects 

You can add a new defect to a TestDirector project at any stage of the testing 
process. In the following exercise you will report the defect that was 
detected while running the Cruise Booking test. 

To add a new defect: 

1 Open the TestDirector_Demo project. 

If the TestDirector_Demo project is not already open, log in to the project. 
For more information, see “Starting TestDirector,” on page 5. 

2 Display the Defects module. 

Click the Defects tab. The Defects Grid displays defect data in a grid. Each 
line in the grid displays a separate defect record. 
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3 Open the Add Defect dialog box. 

Click the Add Defect button. The Add Defect dialog box opens. Note that 
fields that are marked in red are mandatory. 

4 Summarize the defect. 

In the Summary box, type a brief description of the defect. For example, 
type: Unable to reserve a cruise from the Cruise page. 
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5 Specify the defect information. 

In Category, specify the class category of the defect. Select Defect. 

Skip the Detected By box. This field indicates the name of the person who 
detected the defect. By default, the login user name is displayed. 

Skip the Project box. This field indicates the name of the project in which 
this defect was found. Accept the default value. 

In Severity, specify the severity level of the defect. Select 2-Medium. 

Skip the Reproducible box. This field indicates whether the defect can be 
reproduced under the same conditions in which it was detected. Accept the 
default value. 

In Subject, specify the subject in the test plan tree to which the defect is 
related. Select Cruises. 

Skip the Detected on Date box. This field indicates the date on which the 
defect was found. By default, today’s date is displayed. 

In Detected in Version, specify the application version in which the defect 
was detected. Select Version 1.01. 

Skip the Status box. When you initially add a defect to a project, it is 
assigned the status New. 

Skip the Regression field. Accept the default value. 

6 Skip the user-defined fields. 

Click the Next Page arrow. For the purpose of this exercise, skip the 
following fields: Language, Browser, and Operating System. 

Click the Back Page arrow. 

7 Type a detailed description of the defect. 

In the Description box, type a description of the defect. For example, type: 
The defect was detected in the Cruise Booking test. When you click the Now 
Accepting Reservations button, the Flight Finder page opens instead of the 
Cruise Reservation page. 
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8	 Attach the URL address for the Mercury Tours page where the defect was 
detected. 

Click the Attach URL button. The Attach URL dialog box opens. 

Type the URL address of the Mercury Tours page. For example, type: 
http://[server name]/mtours/servlet/com.mercurytours.servlet.ReservationServlet 

Make sure to replace [server name] with your actual TestDirector server 
name. 

Click OK. The URL appears above the Description box. 

9 Spell check your text. 

Place the cursor in the Description box, and click the Check Spelling button. 
If there are no errors, a confirmation message box opens. If errors are found, 
the Spelling dialog box opens and displays the word together with 
replacement suggestions. 

10 Add the defect to the TestDirector project. 

Click the Submit button. A confirmation message box indicates that the 
defect was added successfully. Click OK. 

11 Close the Add Defect dialog box. 

Click Close. The defect is listed in the Defects Grid. 

Matching Defects 

Matching defects enables you to eliminate duplicate or similar defects in 
your project. Each time you add a new defect, TestDirector stores lists of 
keywords from the Summary and Description fields. When you search for 
similar defects, keywords in these fields are matched against other defects. 

Note that keywords are more than two characters, and letter case does not 
affect your results. TestDirector ignores the following: articles (a, an, the); 
coordinate conjunctions (and, but, for, nor, or); boolean operators (and, or, 
not, if, or then); and wildcards (?, *, [ ]). 

In the following exercise, you will match defects by comparing a selected 
defect with all other existing defects in the TestDirector_Demo project. 
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To match defects: 

1 Display the Defects module. 

Click the Defects tab. 

2 Select defect number 37. 

In the Defects Grid, select defect number 37. 

Note that if you cannot find defect number 37 in the Defects Grid, you will 
need to clear the filter that was applied to the grid. To do so, click the Clear 
Filter/Sort button. 

3 Find similar defects. 

Click the Find Similar Defects button. 

Results are displayed in the Similar Defects dialog box. Similar defects are 
displayed according to the percentage of detected similarity. 

Click Close to close the Similar Defects dialog box. 
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Updating Defects 

Tracking the repair of defects in a project requires that you periodically 
update defects. You can do so directly in the Defects Grid, or in the Defect 
Details dialog box. Note that the ability to update some defect fields 
depends on your permission settings as a user. 

In this exercise you will update your defect information. 

To update a defect: 

1 Display the Defects module. 

Click the Defects tab. 

2 Update the defect directly in the Defects Grid. 

In the Defects Grid, select the defect that was added in “Adding New 
Defects” on page 77. 

To assign the defect to a member of the development team, click the 
Assigned to box that corresponds to the defect and select james_td from the 
Assign to list. 
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3	 Open the Defect Details dialog box. 

Click the Defect Details button. The Defect Details dialog box opens. 

4 Change the severity level of the defect. 

Select 5-Urgent from the Severity list. 

5 Add a new R&D comment to explain the change in the severity level. 

Click the Description tab. 

Click the Comment button. A new section is added to the R&D Comment 
box, displaying your user name and the current date. 

Type: This defect also occurs in Mercury Tours version 1.0. 

6 View the Attachments. 

Click the Attachments tab. Note that the URL attachment is listed. 
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7 View the History. 

Click the History tab to view the history of changes made to the defect. For 
each changed field, the date of the change, the name of the person who 
made the change, and the new value are displayed. 

8 Close the Defect Details dialog box. 

Click OK to exit the dialog box and save your changes. 

Mailing Defects 

You can send an e-mail about a defect to another user. This enables you to 
routinely inform development and quality assurance personnel about defect 
repair activity. 

In the following exercise, you will e-mail your defect. 

To mail a defect: 

1 Display the Defects module. 

Click the Defects tab. 
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2 Select a defect. 

Select the defect you added in “Adding New Defects” on page 77, and click 
the Mail Defects button. The Send Mail dialog box opens. 

3 Type a valid e-mail address. 

In the To box, type your actual e-mail address. 

4 Type a subject for the e-mail. 

In the Subject box, type a subject for the e-mail. 

5 Include the attachments and history of the defect. 

In the Include box, select Attachments and History. 

6 E-mail the defect. 

Click Send. A message box opens. Click OK. 

7 View the e-mail. 

Open your mailbox and view the defect you sent. 
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Associating Defects with Tests 

You can associate a test in your test plan with a specific defect in the Defects 
Grid. This is useful, for example, when a new test is created specifically for a 
known defect. By creating an association, you can determine if the test 
should be run based on the status of the defect. Note that any requirements 
covered by the test are also associated with the defect. 

You can also create an association during a manual test run, by adding a 
defect. TestDirector automatically creates an association between the test 
run and the new defect. 

In the following exercise, you will associate your defect with the Cruise 
Booking test in the Test Plan module, and view the associated test in the 
Defects Grid. 

To associate a defect with a test: 

1 Display the Test Plan module. 

Click the Test Plan tab. 

2 Select the Cruise Booking test. 

In the test plan tree, expand the Cruise Reservation sub-folder under 
Cruises. 

Right-click the Cruise Booking test in the test plan tree or Test Grid, and 
choose Associated Defects. 
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The Associated Defects dialog box opens. 

3	 Add an associated defect. 

Click the Associate button. The Associate Defect dialog box opens. 

Click the Select button to select your defect from a list of available defects. 
Click the Associate button. 

An information box opens. Click OK. 
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Click Close to close the list of available defects. Your defect is added to the 
list. 

Click Close to close the Associated Defects dialog box. 

4 View the associated test in the Defects Grid. 

Click the Defects tab. 

Select your defect in the Defects Grid, and choose View > Associated Test. 
The Associated Test dialog box opens. 

➤ The Details tab displays a description of the test. 

➤ The Design Steps tab lists the test steps. 

➤ The Test Script tab displays the test script if the test is automated. 

➤ The Reqs Coverage tab displays the requirements covered by the test. 

➤	 The Test Run Details tab displays run details for the test. This tab is only 
available if the association was made during a test run. 

➤	 The All Runs tab displays the results of all test runs and highlights the 
run from which the defect was submitted. This tab is only available if 
the association was made during a test run. 

Creating Favorite Views 

A favorite view is a view of a TestDirector window with the settings you have 
applied to it. You can save favorite views of the Test Grid, Execution Grid, 
Defects Grid, and all TestDirector reports and graphs. For example, your 
favorite view settings may include applying a filter to grid columns, sorting 
fields in a report, or setting a graph appearance. 

In the following exercise, you will create a favorite view in the Defects Grid. 

To create a favorite view: 

1 Display the Defects module. 

Click the Defects tab. 
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2	 Define a filter to view defects you detected that are not closed. 

Click the Set Filter/Sort button. The Filter dialog box opens. 

Click the Filter Condition box that corresponds to Detected By. Click the 
Browse button. The Select Filter Condition dialog box opens. 

Under Users, select your TestDirector login user name (alice_td, cecil_td, or 
michael_td). Click OK to close the Select Filter Condition dialog box. 

89 



TestDirector Tutorial 

Click the Filter Condition box that corresponds to Status. Click the Browse 
button. The Select Filter Condition dialog box opens. 

Select the logical expression Not. 

Select Closed. 

Click OK to close the Select Filter Condition dialog box. 

Click OK to close the Filter dialog box. The Defects Grid displays the defects 
you detected that are not closed. 

3 Add a favorite view. 

Click the Favorites button, and choose Add to Favorites. The Add Favorite 
dialog box opens. 

In the Name box, type: My detected defects (status ‘Not Closed’). 

You can add a favorite view to either a public folder or a private folder. Views 
in the public folder are accessible to all users. Views in the private folder are 
accessible only to the person who created them. For the purpose of this 
exercise, select Private. 
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Click OK. The new view name is added to the Favorite list. 

Now that you are familiar with how to add new defects, search for similar 
defects, update defects, e-mail defects, associate defects with tests, and create 
favorite views, you can proceed to Lesson 6, “Analyzing the Testing Process”. 
In Lesson 6, you will learn how to generate reports and graphs to help you 
analyze the testing process. 
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Analyzing the Testing Process 

TestDirector reports and graphs help you assess the progress of 
requirements, the test plan, test runs, and defect tracking. You can generate 
reports and graphs any time during the testing process from each 
TestDirector module, using default or customized settings. When 
customizing a report or graph, you can apply filters and sort conditions, and 
display information according to your specifications. You can also save your 
settings as favorite views and reload them as needed. 

In this lesson, you will learn about: 

➤ Generating Reports 

➤ Generating Graphs 

Generating Reports 

You can generate a report from any TestDirector module. Depending on the 
TestDirector module you are in, you have different report options. After you 
generate a report, you can customize report properties to display 
information according to your specifications. 

In the following exercise, you will generate a standard requirements report, 
customize the report for a specific user name, and add it to your favorites 
list. 
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To generate a report: 

1 Open the TestDirector_Demo project. 

If the TestDirector_Demo project is not already open, log in to the project. 
For more information, see “Starting TestDirector,” on page 5. 

2 Display the Requirements module. 

Click the Requirements tab. The Requirements module displays the 
requirements tree. 

3 Choose a report. 

Choose Analysis > Reports > Standard Requirements Report. The report 
opens with default data displayed. 
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4 Display the customization options. 

Click the Report Customization link. The Report Customization page opens 
with the default options selected. 

5 Set the number of items per display page. 

Select All items in one page to display all items in one page. 

6 Skip the Template box. 

You can use TestDirector’s default report template or your own template. For 
the purpose of this exercise, skip this option. 
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7	 Define a filter to view requirements created by a specific user name. 

Click the Set Filter button. The Filter dialog box opens. 

Click the Filter Condition box that corresponds to Author. Click the Browse 
button. The Select Filter Condition dialog box opens. 
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Under Users, select your TestDirector login user name (alice_td, cecil_td, or 
michael_td). Click OK to close the Select Filter Condition dialog box. 

Click OK to close the Filter dialog box. 

8 Determine the appearance and order of the fields. 

Select Custom Fields (layout) and click the Select Fields button. The Select 
Fields dialog box opens. 

The Available Fields box lists fields not currently displayed. The Visible 
Fields box lists fields currently displayed. 

In Visible Fields, select Attachment and click the left arrow button to move 
the field to Available Fields. Move Creation Time and Modified to Available 
Fields. 
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To set the appearance order of the visible fields, select ReqID and use the up 
arrow button to move the field under Author. Move Name and Description 
so that they appear under ReqID. 

Tip: You can also use a drag-and-drop operation to determine the 
appearance and order of the fields. 

Click OK to close the dialog box and apply the new field order. 

9 Clear the Attachment and History options. 

Under the list of options, clear the Attachment and History check boxes. 
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10	 Generate a new report. 

Click the Generate button. The customized report is displayed. 

11 Add the report as a favorite view. 

Click the Add to Favorites button. The Add Favorite dialog box opens. 

In the Name box, type: Standard Requirements by Author. Click OK. The 
report is added to the Reports list in the left pane. 

12 Close the report. 

Click the Back button. The Requirements module is displayed. 

Tip: You can generate a quick report for a single node in a tree or row in a 
grid. Select the requirement, test, or defect, and choose Analysis > 
Report Selected. 

99 



TestDirector Tutorial 

Generating Graphs 

TestDirector graphs help you analyze the relationships between different 
types of data in a project. Depending on the TestDirector module you are in, 
you have different graph options. After you generate a graph, you can 
customize graph properties to display information according to your 
specifications. 

In the following exercise, you will generate a defects graph to summarize the 
defects by status and priority level. 

To generate a graph: 

1 Display the Defects module. 

Click the Defects tab. The Defects module displays the Defects Grid. 

2 Choose a graph. 

Choose Analysis > Graphs > Summary. The Defects Summary graph opens. 
By default, the graph is grouped by defect status. 

100 



Lesson 6 • Analyzing the Testing Process 

3 Set the X-axis of the graph. 

Select Priority from the X-Axis list to view the number of defects by priority. 

4 Define a filter to view defects with high to urgent priority. 

Click the Filter button. The Filter dialog box opens. By default, the Detected 
By field is set to the current user name—your TestDirector login user name 
(alice_td, cecil_td, or michael_td). 
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Click the Filter Condition box that corresponds to Priority. Click the Browse 
button. The Select Filter Condition dialog box opens. 

Select the logical expression >=. 

Select 3-High. 

Click OK to close the Select Filter Condition dialog box. 

5 Define a filter to view defects that are not closed. 

Click the Filter Condition box that corresponds to Status. Click the Browse 
button. The Select Filter Condition dialog box opens. 

Select the logical expression Not. 

Select Closed. 

Click OK to close the Select Filter Condition dialog box. 

Click OK to close the Filter dialog box. 
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6	 Refresh the graph. 

Click the Refresh button. A new graph is displayed. 

In the above example, five open defects are assigned 3-High, three open 
defects are assigned 4-Very High, and one reopened defect is urgent. 

7 Display additional defect details. 

Click a bar segment in the graph. The Drill Down Results dialog box opens 
and displays the defects that define the bar segment. 
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For example, if a bar segment indicates a total of five defects, the Drill Down 
Results displays the five defects. 

You can modify the information in the grid, and determine the column 
appearance and order. For the purpose of this exercise, skip this option. 

Click Close to exit the Drill Down Results dialog box. 

8 Display other graph views. 

Click the Pie Chart tab to display the bar graph as a pie graph. 

Click the Data Grid tab to display the pie graph as a grid. 

9 Close the graph. 

Click the Back button. The Defects module is displayed. 

Now that you are familiar with generating reports and graphs, you can 
proceed to Lesson 7, “Where Do You Go from Here?”. In Lesson 7, you will 
apply the TestDirector concepts and skills you learned to your own 
application. 
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Where Do You Go from Here? 

Now that you have completed exercises in Lessons 1 through 6, you are 
ready to apply the TestDirector concepts and skills you learned to your own 
application. 

In this lesson, you will learn about: 

➤ Getting Started 

➤ Getting Additional Information 

Getting Started 

Test management with TestDirector includes four phases: specifying 
requirements, planning tests, running tests, and tracking defects. 
Throughout each phase, you can analyze data by generating detailed reports 
and graphs. 

To get started: 

1 Analyze you application and determine your testing requirements. 

To specify your testing requirements, consider the following steps: 

➤	 Examine application documentation in order to determine your testing 
scope—test goals, objectives, and strategies. 

➤ Build a requirements tree to define your overall testing requirements. 

➤	 For each requirement topic in the requirements tree, create a list of 
detailed testing requirements. Describe each requirement, assign it a 
priority level, and add attachments if necessary. 
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➤	 Generate reports and graphs to assist in analyzing your testing 
requirements. Review your requirements to ensure they meet your 
testing scope. 

2 Create a test plan, based on your testing requirements. 

To create a test plan, consider the following steps: 

➤	 Examine your application, system environment, and testing resources in 
order to determine your testing goals. 

➤	 Divide your application into modules or functions to be tested. Build a 
test plan tree to hierarchically divide your application into testing units, 
or subjects. 

➤	 Determine the types of tests you need for each module. Add a basic 
definition of each test to the test plan tree. 

➤ Link each test with a testing requirement(s). 

➤	 Develop manual tests by adding steps to the tests in your test plan tree. 
Test steps describe the test operations, the points to check, and the 
expected outcome of each test. Decide which tests to automate. 

➤	 For tests that you decide to automate, create test scripts with a Mercury 
Interactive testing tool, or a custom or third-party testing tool. 

➤	 Generate reports and graphs to assist in analyzing test planning data. 
Review your tests to determine their suitability to your testing goals. 

3 Create test sets and perform test runs. 

➤	 Define groups of tests to meet the various testing goals in your project. 
These might include, for example, testing a new application version or a 
specific function in an application. Determine which tests to include in 
each test set. 

➤ Schedule test execution and assign tasks to application testers. 

➤ Execute the tests in your test set automatically or manually. 

➤	 View the results of your test runs in order to determine whether a defect 
has been detected in your application. Generate reports and graphs to 
help analyze these results. 
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4	 Report defects detected in your application and track how repairs are 
progressing. 

➤	 Report new defects detected in your application. Quality assurance 
testers, developers, project managers, and end users can add defects 
during any phase in the testing process. 

➤ Review new defects and determine which ones should be fixed. 

➤ Correct the defects that you decided to fix. 

➤	 Test a new build of your application. Continue this process until defects 
are repaired. 

➤	 Generate reports and graphs to assist in analyzing the progress of defect 
repairs, and to help determine when to release the application. 

Getting Additional Information 

For more information on TestDirector, refer to the user’s guides and online 
resources provided with TestDirector. 

TestDirector Documentation Set 

In addition to this guide, TestDirector comes with the following printed 
documentation: 

TestDirector Installation Guide explains how to install TestDirector and the 
client database software needed to connect TestDirector to project databases. 

TestDirector User’s Guide explains how to use TestDirector to organize and 
execute all phases of the testing process. It describes how to define 
requirements, plan tests, run tests, and track defects. 

TestDirector Administrator’s Guide explains how to customize projects 
using the Project Customization window and how to create and maintain 
projects using the Project Administration utility. 
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TestDirector Open Test Architecture Guide explains how to use 
TestDirector’s open test architecture to integrate your own configuration 
management, defect tracking, and home-grown testing tools with a 
TestDirector project. It includes a complete reference to TestDirector’s new 
COM-based API. 

Online Resources 

TestDirector includes the following online resources: 

Read Me First provides last-minute news and information about 
TestDirector. 

What’s New in TestDirector describes the newest features in the latest 
versions of TestDirector. 

Books Online displays the complete documentation set in .PDF format. 
Online books can be read and printed using Adobe Acrobat Reader 5.0, 
which can be downloaded from the Adobe Web site 
(http://www.adobe.com/products/acrobat/readstep2.html). 

TestDirector Online Help provides immediate answers to questions that arise 
as you work with TestDirector. It describes menu commands and dialog 
boxes, and shows you how to perform TestDirector tasks. Check Mercury 
Interactive’s Customer Support Web site 
(http://support.mercuryinteractive.com) for updates to TestDirector help files. 

Technical Support Online uses your default Web browser to open Mercury 
Interactive’s Customer Support Web site. The URL for this Web site is 
http://support.mercuryinteractive.com. This site enables you to browse the 
knowledge base and add your own articles, post to and search user 
discussion forums, submit support requests, download patches and updated 
documentation, and more. 

Support Information presents Mercury Interactive’s Customer Support Web 
site and home page, the e-mail address for requesting information, and a list 
of Mercury Interactive’s offices around the world. 
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Mercury Interactive on the Web uses your default Web browser to open 
Mercury Interactive’s home page. This site provides the most up-to-date 
information on Mercury Interactive and its products. This includes new 
software releases, seminars and trade shows, customer support, educational 
services, and more. The URL for this Web site is 
http://www.mercuryinteractive.com. 
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Mercury Interactive Corporation 
1325 Borregas Avenue

Sunnyvale, CA 94089 USA


Main Telephone: (408) 822-5200

Sales & Information: (800) TEST-911, (866) TOPAZ-4U

Customer Support: (877) TEST-HLP

Fax: (408) 822-5300


Home Page: www.mercuryinteractive.com

Customer Support: support.mercuryinteractive.com 
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